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The Fixplot program is a component program of Eyenal that allows the user to
plot eye position data collected with Applied Science Laboratories series 4000,
5000, and model ETS eye tracking systems. Raw data files (.eyd or .ehd) and
calculated fixations files ( .fix ) can be plotted over any bitmap image.

This tutorial will explain the process of plotting scan paths over bitmap images,
manipulating the scan path displays, and creating Area of Interest files. In most
but not all cases the bitmap image used will be of the scene the subject(s) viewed
while data was recorded. Commonly these bitmap images are computer generated
or captured through scene cameras.




Open Image...




= FinPlo




:jFixPlot -Your Scene.bmp
Ed

For Help, pr



To find the coordinates for 2
known points in the original scene

image follow the proceeding steps
A-F.

These steps are performed outside
of the Fixplot program and
hereafter should be performed
before step 4.
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A) enable the "Set Target Mode" on the
interface program. This can be found under the
Calibrate pull down menu.

B) Once the pop up menu for Set Target Points
appears, move the mouse into the Scene POG
display on the interface program.

(Scene POG = black box on the right of the
screen that indicates the nine target points).

C) The Scene POG window is a digital
representation of what the subject is viewing.

D) Once the mouse is with-in the Scene POG
window you will see the corresponding position
on the "Scene monitor” represented by a cursor
or X-hair.

E) Move the mouse with-in the scene POG
window until it is over a given point (we'll call
it attachment point 1 for Fixplot) and write
down the Hor and Ver coordinates displayed in

the Set Target Points window as Scene X: Y:

, see picture. Also note that you will have to re-
identify that exact point again for Fixplot once
the bitmap image is opened.

F) Repeat the above step so that you have 2
known points and associated Hor and Ver
coordinates on the desired image.
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Enter the coordinates of Attachment
point 1

X = horizontal or H1

Y= vertical or V1

Enter the coordinates of Attachment
point 2

X = horizontal or H2

Y= vertical or V2

The Co-ordinate system should always
be # 1

Click “OK”
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Note: having Fixplot display the attachment points (see picture) is an option. To make Fixplot display
the attachment points: Pull down the Options menu and select Preferences. In the resulting pop-up menu
choose the Other tab and check the box next to “Show Attachment Points”.
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Preferences [C:\ASL Softwareitest files\demo image _..
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Eyenal - [demo image data_epd]

) File Wiew Fization ADl Fzeg Dwel Pupil Batch ‘Window Help ;I_illl
sEEEE PR
[=1- demo image data.e subject_id= ﬂ
- Segment 1 start_flag=
demo image stop_flag=
mir_fix_sample= 6 ﬂ
Seq No. | Fix No, | Pin No, [ Stit Time, | Fis Dur, | InterFis Dur | InEea | Hor Pos, | Var Pos, | Pupil Diar, | Eye/Sen Dist, | No_of flags. | Fis
Eyenal ] 1 0 | 155419. 0967 0.000 0.000 36,590 0.000 1 [
b 1] 15:64: .
. . ] 2 0 155420. 0217 0.017 2,560 56140 69790
leatlon ] 3 0 155420. 0233 0.017 0.740 65.470 | £A.070 E 1
1 4 0 155421.. 0.767 0017 1460 E7.830 | B3450 yena
] 5 0 [155421.. | 2383 0.050 5,330 127.220 | 91.170
S ] 6 0 155424, 2100 0.057 £.540 192,030 69.330
equence ] 7 0 155426. 0217 0.150 0.450 195,000 | 72.860 0 Dwell
] ] 0 155426. 0467 0117 1.200 193,360 | 84.730 32550 0.000 0 0 \
. ] E] 0 155427. 0.200 0.033 3,250 217.770 | 106460 | 32.380 0.000 0 i .
An31YSIS 1 10 0 155427 0.250 0m? 1.760 203000 | 116000 | 33.000 0.000 0 C Analys18
] 11 0 [155427.. | 0.383 0.050 3.930 166,630 | 132230 | 34.210 0.000 0 [
] 12 0 155426. 0433 0.017 2,550 191.890 | 135530 | 35.780 0.000 0 [
] 13 0 | 155426.  0.250 0.150 15.020 47440 94.440 37.000 0.000 0 i
] 14 0 155429. 0.200 0.017 1.270 51150 | 82310 36.920 0.000 0 0
] 15 0 | 155429. 0583 0.017 1.720 BEEO0 | 74.440 36.390 0.000 0 [
] 16 0 155430.  1.400 0.017 0.240 B5.350 | 72240 37.390 0.000 0 [
] 17 0 155431 0.200 0.050 4,350 46690 111.620 | 37.000 0.000 0 i
] 18 0 155431 0317 0.033 3.560 61750 | 79150 37.750 0.000 0 0
] 19 0 [155432. | 1.167 0.017 0.630 BEA450 | 74150 37.210 0.000 0 [
] 20 0 |155433. | 0317 0.017 1.500 72250 | 88000 36.950 0.000 0 [
] 2 0 155433. 0683 0.057 5.630 128500 | 90.260 35610 0.000 0 i
] 2 0 155434. 0250 0.017 1.840 110,250 92.880 36,630 0.000 0 0
] 23 0 155434 0167 0.017 2210 132,000 | 89180 36.540 0.000 0 [
] 24 0 155434 0417 0133 0.550 127.150 | 8R.650 37.040 0.000 0 [
] 25 0 155435. 0217 0.017 1,160 116570 | 91.430 37.070 0.000 0 i
] 26 0 155435. 2417 0.017 1.280 129330 90.630 36.210 0.000 0 0
] 27 0 [155436.. | 0.267 0.017 1.200 117.410 | 92.000 37.680 0.000 0 [
] 2 0 [155436. | 0333 0.017 1.660 133,900 | 93710 36.140 0.000 0 [
] 23 0 155436. 0633 0.057 9.530 118310 | 187.720 | 37.900 0.000 0 i
] 30 0 [155439. | 1.883 0.017 0.930 118070 | 196970 | 34.540 0.000 0 0
4 | |
segment_start_time=15:54:19.650 -
segment_end_time= 15:54:41 283
segment_duration_time= 00:00:21 650
number of fixations= 30 = |




B =

=1 atic seg well P Bz =] =]
H el aal == z|s2| |
- e;-cample_eyd aoi_file_title= example aoi 3
i Segrent 1 aoi_file_name= CIProgram Fileswa s Evenahexample . aoi
1 example. fiz fix_file_title=
H Searnent 1 fiz_file_name= example fix _v_l
- example. aoi = = = = = — 5
- example.fzq Seg_Mao I Fix Mo ! Flin_ Mo i A0 Mo I A01_Mame i Strt_Time I Fi=_Cour i InterFi=_Diur i InterFix_Deg ! Pupil_Diarn I EvesSch DISl_i Mo _of flags _i
= Sedgment 1 1 1 u} 5 area 5 16:10:4. . 0.980 0.000 0.000 34.344 0.000 1
. = a 16:10...
: ’.?D' il 1 2 ] 5 area s 16:10:4.. | 0160 0.020 1,292 36.000 0.000 0
zotranzlbiontoble. 1 3 1] 4 area 4 16:10:5. . 0.680 0.020 7.403 34,941 0.000 [u}
- Conditional probability 1 4 1] 4 area 4 16105 | 0450 0.020 0.366 33.957 0.000 ]
o Jaint probabilite 1 5 o a off 16:10:5... 0.240 0.020 10.850 34.833 0.000 a
1 E u} a off 16:10:5... 0.260 0.020 0.536 34615 0.000 u]
1 7 o a off 16:10:5... 0.020 0.080 9.900 234,750 0.000 a
1 2 u} 5 area 5 16:10:5... 0.140 0.020 2070 24.000 0.000 a
1 =] u} 1 area 1 16105 0.280 0.020 11.357 25.000 0.000 a
1 10 u} 1 area 1 16:10:5... 0.500 0.020 0.551 35280 0.000 u]
1 11 a 2 area 2 16:10:5... 0.080 0.100 12.029 25.000 0.000 a
1 12 a 2 area 2 16:10:5... 0.580 0.040 2.070 35241 0.000 a
1 132 o 4 area 4 16:10:5... 0.140 0.020 13.367 25.000 0.000 a
1 14 u} 4 area 4 16:10:5... 0.740 0.020 1.421 25.000 0.000 a
1 15 o ] area 3 16:10:5... 0.100 0.080 13.388 35.800 0.000 a
1 16 u} k] area 3 16:10:5... 0.720 0.020 1.676 35.583 0.000 a
1 17 a 1 area 1 16:10:5... 0.540 0120 14.099 34.222 0.000 a
1 1g u} 1 area 1 16:10:5... 0.100 0.220 0.483 34,200 0.000 u]
1 19 o 2 area 2 16:10:5... 0720 0.020 14.446 33.556 0.000 u}
1 20 a 4 area 4 16:10:5... 0.780 0.080 14.433 33.870 0.000 a
1 21 o a off 16:10:5... 0.0&60 0.020 8. 736 25.000 0.000 a
1 22 u} ] area 3 16:10:5... 0.580 0.020 5922 35.034 0.000 u]
1 23 o a off 16:10:5... 0.020 0.020 10.834 35.000 0.000 a
1 24 u} 1 area 1 16:10:5... 0.200 0.060 3935 24,200 0.000 u}
1 25 a 1 area 1 16:10:5... 0.400 0220 0.050 234,700 0.000 a
1 26 u} 2 area 2 16:10:5... 0160 0.100 14.067 34625 0.000 u]
1 27 a 2 area 2 16:10:5... 0.540 0.020 0.596 34.963 0.000 a
1 28 a 4 area 4 16:11:0.... 0120 0.080 131532 24.000 0.000 a
1 29 o 4 area 4 16:11:0.... 0.440 0.020 1.584 234.045 0.000 a
segment_start_time= 16:10:45.800 -
segment_end_time= 16:11:01 100
segment_duration_time= 00:00:12.300
number_of_fixations= 29 -v_I
For Help. press F1 | |




Eyenal - [example.eyd] _i__l— = .?.(J
File Edit “iews Fization A0l Fzeg Dwell Pupil Batch ‘Window Help = iﬁl|i]
D!@Inl ﬁiﬁl @l!@ll hl-bl ‘?Ik‘?l
El- example. spd Fix Sequence Area of Interest Segment Summary ;I
“ Segment 1
e?-:ample.fi:-:
‘o Segment 1 ;I
example. aoi
emarnple.fag AdlL_Mo I Fln_fHa I A0l _Mame I Surm_Fix_Dur I Fist Dur_= I Sum_Fix_Cnt I Fix_Cht_ % I tMean Fiz_ Dur I tMean_|nterFiz Dur | Mean InterFiz Dist I tean_FD I
Bl Segment 1 a o off 0.720 E.630 5 17.241 0.144 0.050 5.218 34.840
L 1 u] area 2.020 18.600 ] 20,690 0.337 0.153 0.363 34.600
T i rabl 2 0] area 2 2.080 19.153 =] 17.241 0416 0.030 1.833 34677
st . 3 0 area 3 1.400 12.891 3 10.345 0.457 0.020 1.67E 35.473
i Conditional prabability 4 0 area 4 3.360 30,939 7 24138 0,420 0.020 1.124 34402
= Jaint prabability L] u] area b 1.280 11.786 3 10.345 0,427 0.0z20 1.292 34.781
For Help. press F1 |
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Eile  Edit “iew Fization A0l Fzeg Dwell PFupil Batch “Window Help B !5’!1!
DilE 2w U] =]=] 2]
e?-cample_eyd Fix Sequence Transitions 1 _:j
Segment 1
=] e;-cample.fi:-c
Segment 1 __'_I
example. aoi
example fsq a0lre. | o | 1 | 2 | 3 | 4 | 5 |
- Segment 1 o 2 1 a 1 a 1
i SO zumimary 12 g g g g g g
g Tran 1 table 3 1 q 0 q a a
i Conditional probability 4 z o o q 3 i]
i Jaint probability 5 u} 1 i} 1] 1 1

File Edit “iew Fization A0l Fseg Dwell Pupl Batch “indow Help
mi = e @ | e =]=] @Ig.?”
7 e?-cample.eyd Fix Seguence Conditional Probakilities 1
i Segment 1
- example. fix
Lo Segrnent 1
- example. aoi
S e solnc | 0 |1 12 | =1 4 | 51
I Searnent 1 i 0400 0200 0000 0200 0000 0200
= 1 0000 | 0500 0500 0000 0000 0000
: ’;‘D' SF:.mmf"fjl 2 0.000 | 0000 0400 0000 0600 0.000
RSl 3 0333 0333 0000 0333 0000 0000
4 0333 0000 0000 0167 0500 | 0000
5 0000 0333 0000 0000 0333 0333

’ZEyenal - [example. epd]

3 Eile

Edit “iews Fixation A0l Fseg Dwell Pupil Batch “Window Help
DlE] =8 e == 2|
El- example. epd Fix Sequence Joirt Probabilities 1
- Segment 1
(= example. fis
. - Segment 1
- emarnple. aoi
example fq s0lre | o | 1 ] 2 | = 1| 4 | 5 |
=B oomeni i D000 G107 0107 DODD 0000 01006
’;‘D' AT 2 0.000 0000 0071 0.000 0407 0.000
ARSI L abIgs, 3 0036 0036 0000 0036 0000 0000
Conditional probability 4 0071 0000 0000 003 0107 0000
5 0.000 003 0000 0000 0036 0036
[ ] [ ] [ J [ J [ ] [ ] [ ]



Eyenal - [example._eypd]

1 File Edit “iew Fixation

201

Fzeg Dwell Pupl EBatch “Window Help

=]
1= ]

sl = TREEE]

ajal =[=| =]

=~ erample.epd
! § Segrment 1
example. fiz

: Segment 1
example. aci
example.fzq
= Segrnent 1
example. dwl

A0] surnmary
Transition table
Conditional probability
Jaint prabahility
Histograr 1
Histograr 2
Hiztogram 3
Hiztograr 4
Hiztogram 5

- Histogram B

For Help. pres=s F1

f=o_file_name= example fzq
f=o_file_title=
f=o_segment_number= 1

aoi_file_title= example aoi __v_l

Dwell Mo | 401 Mo | &0 Mame | Pln Mo | Skt Time | Dwl Dur | Stop_ Time | InterFiz Dur | Mo of fags |

1 5 area 5 i 16:10:4.. 1140 161049 0.000 1

= a 1E: 1048 .

2 4 area 4 a 16:10:5... 1.140 | 161051... 0.080 ]

3 ] off i 16:10:5... 0520 | 161051... 0.080 ]

4 5 area 5 i 16:10:5... 0140 161051... 0.020 ]

5 1 area i 16:10:5... 0720 | 161052 0.080 1]

[ 2 area 2 a 16:10:5... 0.BED | 161053.... 0.100 1]

7 4 area 4 a 16:10:5... 0820 | 161054 0.080 ]

3 3 area 3 i 16:10:5... 0820 | 161055.. 0.080 ]

3 1 area i 16:10:5... 0.640  16:1056... 0.120 ]

10 2 area 2 o 16105 0720 | 161057.... 0.080 ]

11 4 area 4 a 16:10:5... 0720 | 161057... 0.080 1]

12 ] off o 16:10:5... 0.060 | 161053 0.080 o

13 3 area 3 i 16:10:5... 0520 | 161058 0.080 ]

14 o off a 16:10:5... 0.020 | 1610:53.. 0.080 ]

15 1 area a 16:10:5... 0600 | 1610:59.. 0.080 1]

16 2 area 2 ] 16:10:5... 0700 1611.0.4. 0.100 o

17 4 area 4 o 16:11:0... 058D 18:11:1.0. 0.080 ]
=
=]

| [ |
[ J [ [




«x Eyenal - [example.eyd] = iEl_?__(_I
Fil= Edit %iew Fization A0l Fseg Dwell Pupl Batch “Window Help = iﬂlﬂ
DR el ala] == 2|
E e;-cample.eyd Fix Dwwell Sequence Area of Interest Summary ;i
- Segment 1
mample. fix
-~ Segment 1 ;I
example. aoi
et A01_Mo | #01 Mame | Pin Mo | Dwi Crt | Mean Dwi | Sigma Dwil | Median Dwl | Skew |
: a off a 3.000 0.240 0.241 0.020 0160
q area 1 a 3.000 073 0.077 0.640 0.033
2 area 2 a 2.000 0.693 0.025 0.700 -0.007
3 area 3 a 2.000 0.700 0120 0.700 0.000
; MBI 4 area 4 a 4.000 0.840 0.208 0.830 0.010
Transition table 5 area b a 2.000 0.640 0.500 0.640 0.000
Conditional probability
Joint probability
Hiztogram 1
Hiztagram 2
Histogram 3
Hiztogram 4
Histogram 5
i Hiztogram &
ikFor more information on Fseq and Dwell
=
=l

For Help, press F1




The End

ASL SOFTWARE

s




	ASL SOFTWARE
	Fixplot   Introduction:The Fixplot program is a component program of Eyenal that allows the user to plot eye
	Step 1: Open FixplotClick the File menu and select “Open Image” as seen below.
	Step 2: Once you have selected “Open Image” the below pop-up menu will appear. Browse to the directory containing the bitmap
	Step 3: Once you have opened the desired image, Fixplot will immediately  display the below pop-up menu. This menu asks the u
	Step 4: Attach a Coordinate System This step requires the user to indicate 2 known points (horizontal & vertical coordinates
	Note these steps require that the Eyetracker be powered on,  the interface program be on line and the scene monitor be display
	Step 5:Enter the coordinates of two known points in the selected image
	Step:6Once you have enterd the coordinates for Attachments points 1 & 2 the program will display a X-hair with a “P1” label (
	Step:7 Once Attachment Point 1 has been set (yellow arrow in picture), the cursor will show a “P2” label  (black arrow in pic
	Once the Attachment Points have been set, Fixplot can be used to superimpose fixation scan paths and to create Areas of Intere
	Step :8To superimpose a fixation file
	To adjust the appearance of the appended fixation file, right click on any fixation point and select “File drawing Properties”
	To view a subset of fixations in the appended fixation file, right click on any fixation point and select “Output Type” from t
	Choose Output Type: - by sequence of fixations                                   - time in seconds
	Step: 9Create Areas of Interest (AOIs) for statistical results. Pull down the Tools menu and select “Input AOIs”(see pictur
	Step: 9 continuedOnce an AOI has been selected the mouse will be a X-hair labeled AOILeft click the mouse and drag to create
	Once an AOI has been designated Fixplot will ask for a name (see picture)After naming the current AOI  one can continue to cr
	Step: 10To save the created AOIS as a file, pull down the file menu and choose “Save AOIs” (see picture)
	Step 11:Once an AOI file has been saved it can be used by Eyenal to calculate further statistical results.
	FSQ(Fixation Sequence) - matches fixation data created with FIX to Area of Interest files created with AOI and produces stati
	FSQ: Summary Table
	FSQ: Calculate Transitions as well as the Conditional and Joint Probability of those transitions
	DWELL - reads FSQ files and computes various dwell statistics about  fixations on Areas of Interest(AOI). Dwells are defined
	Dwell statistics
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